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Author Questionnaire:
1. Microscopy: Does your protocol involve video microscopy? N
2. Does your protocol include software usage? Y
If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps. Please upload all screen captured files to your project page.
3. Which steps from the protocol section below are the most important for viewers to see? 
3.8., 3.9., 4.1.
4. What is the single most difficult aspect of this procedure and what do you do to ensure success? 
5, 6. To ensure success it is essential to make sure the BNC and MN masks are created properly with the parameters provided in this protocol.
5. Will the filming need to take place in multiple locations? N


Section - Introduction
Videographer: Interviewee Headshots are required. Take a headshot for each interviewee.

1. REQUIRED Interview Statements (Said by you on camera): All interview statements may be edited for length and clarity.

1.1. Matthew Rodrigues: The ImageStream based micronucleus assay can overcome several limitations of methods such as automated microscopy and conventional flow cytometry, including low throughput and lack of visual confirmation of events [1].

1.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera

1.2. Matthew Rodrigues: The main advantage of this technique is that all required events to determine genotoxicity and cytotoxicity can be automatically imaged, identified, and scored without the need to create microscope slides [1].

1.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera



Section - Protocol
2. Clastogen and/or Aneugen Exposure
2.1. For cell exposure to clastogens and/or aneugens (an-you-jens), add 1 milliliter of the chemical of interest to 7-8 x 105 of the experimental cells in 9 milliliters of the appropriate cell culture medium in a T25 (T-twenty-five) flask [1-TXT] and 1 milliliter of water to the control cultures [2].
2.1.1. WIDE: Talent adding chemical to flask, with chemical container visible in frame TEXT: See text for all medium/reagent preparation details
2.1.2. MED: Talent adding water to flask

2.2. Incubate the flasks at 37 degrees Celsius and 5% carbon dioxide for 3 hours [1] before transferring the cells to one 15-milliliter polypropylene tube per flask [2].

2.2.1. MED: Talent placing flask(s) into incubator
2.2.2. CU: Cell(s) being added to tube, with flasks visible in frame

2.3. Collect the cells by centrifugation [1-TXT] and resuspend the pellets in 10 milliliters of fresh culture medium per tube for seeding in new T25 culture flasks [3].

2.3.1. MED: Talent adding tube(s) to centrifuge TEXT: 8 min, 200 x g, RT
2.3.2. CU: Shot of pellet if visible, then medium being added to tube, with medium container label and culture flasks visible in frame

2.4. Then add 150 microliters of the stock concentration of cytochalasin B (sight-O-cal-ay-sin B) to each flask to achieve a final concentration of 3 micrograms/milliliter [1] and return the flasks to the incubator for a recovery time equal to 1.5-2 doubling times, as recommended by the Organization for Economic Co-Operation and Development guidelines [2].

2.4.1. MED: Talent adding cytochalasin B to flask(s), with cytochalasin B container visible in frame
2.4.2. MED: Talent placing flask(s) into incubator

3. Sample Processing

3.1. At the end of the recovery period, transfer the cultures into individual 15-milliliter polypropylene tubes for centrifugation [1] and resuspend the pellets in 5 milliliters of 75 millimolar potassium chloride [2].

3.1.1. WIDE: Talent adding cells to tube(s), with flask(s) visible in frame
3.1.2. CU: Shot of pellet if visible, then KCl being added to tube, with KCl container label visible in frame (Author Comment: The pellet would not be visible at this point since it must be re-suspended before adding KCl. Therefore, we did not get a closeup of the pellet in 3.1.2)

3.2. Mix gently by inversion three times [1] and incubate the samples at 4 degrees Celsius for 7 minutes [2].

3.2.1. MED: Talent inverting tube(s)
3.2.2. MED: Talent placing tube(s) at 4 °C

3.3. At the end of the incubation, add 2 milliliters of 4% formalin to each sample [1] and mix gently with three inversions [2].

3.3.1. MED: Talent adding formalin to tube(s), with formalin container visible in frame
3.3.2. CU: Tube(s) being inverted

3.4. Return the samples to 4 degrees Celsius for 10 minutes [1-TXT] before collecting the cells by centrifugation [2].

3.4.1. MED: Talent placing tube(s) into centrifuge TEXT: Soft fixation
3.4.2. CU: Tube(s) being placed into centrifuge

3.5. Resuspend the pellets in 100 microliters of fresh 4% formalin for 20 minutes [1-TXT].

3.5.1. CU: Shot of pellet(s) if visible, then cells being resuspended with formalin, with formalin container label visible in frame TEXT: Hard fixation

3.6. At the end of the incubation, wash the fixed cells in 5 milliliters of wash buffer per tube by centrifugation [1] and resuspend the pellets in 100 microliters of wash buffer per tube [2].

3.6.1. MED: Talent adding wash buffer to tube, with wash buffer container visible in frame
3.6.2. CU: Shot of pellet if visible, then wash buffer being added to tube, with wash buffer container label visible in frame (Author Comment: The pellet would not be visible since it would have to be resuspended to add the wash buffer, so we did not film the pellet here.)

3.7. [bookmark: _GoBack]Next, transfer the samples to individual 1.5-milliliter microcentrifuge tubes for counting on a hemocytometer [1] and add 5 microliters of 100 microgram/milliliter Hoechst (“herkst”) 33342 (three-three-three-four-two) per 1x106 cells/milliliter [2] and 10 microliters of 500 micrograms/milliliter RNase per 100 microliters of sample per tube [3].

3.7.1. MED: Talent adding cells to tube(s)
3.7.2. MED: Talent adding either Hoechst 33342, with both reagent container visible in frame
3.7.3. CU: RNase being added to tube, with both reagent container labels visible in frame Videographer/Video Editor: This step may be excluded at the Author’s discretion (Author Comment: We ended up filming 3.7.3 in case you need some extra footage to work with. If not, omission of 3.7.3 in the video is fine.)

3.8. After a 30-minute incubation at 37 degrees Celsius and 5% carbon dioxide [1], centrifuge the samples in a microcentrifuge [2-TXT] and remove all but 30 microliters of supernatant from each tube [3].

3.8.1. MED: Talent removing tube(s) from incubator
3.8.2. MED: Talent placing tube(s) into microcentirufge TEXT: 8 min, 200 x g
3.8.3. CU: Supernatant being removed from tube

3.9. Then carefully resuspend the samples, taking care not to induce bubble formation [1-TXT]. If bubbles do appear upon resuspension, gently flick the tube to remove them [2].

3.9.1. CU: Sample being resuspended
3.9.2. CU: Tube being flicked TEXT: Do not vortex

4. Multispectral Imaging Flow Cytometry (MIFC)

4.1. To run the samples by multispectral imaging flow cytometry, first turn on the 405-nanometer laser [1] and set the laser power to 10 milliwatts [2].

4.1.1. WIDE: Talent turning on laser
4.1.2. MED: Talent setting laser power to 10 mW, with monitor visible in frame
4.1.3. [Added Shot]: MED: Talent loading sample (Author Comment: We got a shot of me loading a sample into the instrument) (Editor: I’m not sure this needs to be used. If the author wants to use it, they’ll have to either specify when or provide additional VO)
4.1.4. [Added Shot]: CU: screen are with sample information (volume, time remaining, etc.) (Author Comment: We also got a shot of the sample information section of the screen which shows the volume loaded, flow speed and time remaining until the sample runs out) (Editor: I’m not sure this needs to be used. If the author wants to use it, they’ll have to either specify when or provide additional VO)

4.2. Disable all of the other lasers including the side scatter laser and set the brightfield to channels 1 and 9 [1].

4.2.1. SCREEN: To be provided by Author: Laser(s) being disabled, then BF being set to channels 1 and 9

4.3. Confirm that the magnification slider is set to 60x, that the high-sensitivity mode is selected, and that only channels 1, 7, and 9 are showing in the image gallery [1].

4.3.1. SCREEN: To be provided by Author: Magnification slide being set to 60x, high-sensitivity mode being selected, then shot of channels 1, 7, and 9

4.4. Click Scatterplot and select the All population and Area M01 (M-oh-one) on the X-axis [1].

4.4.1. SCREEN: To be provided by Author: Scatterplot being clicked, then All and Area M01 being selected

4.5. Select Aspect Ratio M01 on the Y-axis and click Square Region to draw a region around the single cells [1].

4.5.1. SCREEN: To be provided by Author: Aspect Ratio M01 begin selected, then Square Region being clicked and region being drawn

4.6. Name this region Single Cells and right-click on the plot to select Regions [1].

4.6.1. SCREEN: To be provided by Author: Region being named, then plot being right-clicked and Regions being selected

4.7. Highlight the Single Cells region and change the x-coordinates to 100 and 900 and the y-coordinates to 0.75 and 1 [1-TXT].

4.7.1. SCREEN: To be provided by Author: Single Cells being highlighted, then x- and y-coordinates being selected TEXT: See text for additional plot preparation details

4.8. Set the acquisition parameters and specify the file name and the destination folder [1].

4.8.1. SCREEN: To be provided by Author: Parameter(s) being set, then file name and folder being specified

4.9. Then change the number of events to 20,000, select the DNA-positive population, and run the first sample [1] [2].

4.9.1. SCREEN: To be provided by Author: Event number being changed, then DNA-positive population being selected and acquire being pressed.
4.9.2. MED: Talent loading sample (Author Comment: We filmed me loading the sample in step 4.1.3. So I’ve removed this step and took a screenshot of everything else, plus me pressing the ‘acquire’ button to begin collecting data.)

5. Binucleated Cell (BNC) Identification

5.1. To open a data file in IDEAS (ideas), click Start Analysis to start the Open File Wizard [1] and browse to select the desired raw image file [2].

5.1.1. WIDE: Talent clicking Start Analysis, with monitor visible in frame
5.1.2. SCREEN: To be provided by Author: Files being browsed/file being selected

5.2. Then click Open button and Next and browse for a binucleated cell in the image gallery [1].

5.2.1. SCREEN: To be provided by Author: Open and Next being clicked, then images being browsed

5.3. To create a mask, click to select the image of interest and open the Analysis tab [1].

5.3.1. SCREEN: To be provided by Author: Image being selected, then Analysis being selected

5.4. Click Masks, New, and Function to select LevelSet [1].

5.4.1. SCREEN: To be provided by Author: Masks, New, and Function being clicked, then LevelSet being selected

5.5. Under Mask select M07 and Middle Level Mask and set the Contour Detail Scale to 3 [1].

5.5.1. SCREEN: To be provided by Author: M07 and Middle Level Mask being selected, then Contour Detail Scale being set to 3

5.6.  Then click OK two times [1].

5.6.1. SCREEN: To be provided by Author:  Ok and Ok being clicked
 
5.7. To spot count binucleated cell features, open the Analysis tab, and select Features and New [1].

5.7.1. SCREEN: To be provided by Author: Analysis being opened, then Features and New being clicked

5.8. For the Feature Type, select Spot Count. For Mask, select the final binucleated mask and set the Connectedness to Four [1].

5.8.1. SCREEN: To be provided by Author: Spot Count being selected, then Mask being selected and Connectedness being set to Four

5.9. Then change the name to Spot Count BNC (B-N-C) and click OK and Close to calculate the feature values [1].

5.9.1. SCREEN: To be provided by Author: Name being changed, then Ok and Close being clicked/feature values being calculated 

5.10. [bookmark: _Ref524097672]For a spot count binucleated cell histogram, click Histogram and select Non-apoptotic as the parent population [1].

5.10.1. SCREEN: To be provided by Author: Histogram and Non-apoptotic being clicked

5.11. For the X-axis feature, select Spot Count BNC and click OK and Linear Region [1].

5.11.1. SCREEN: To be provided by Author: Spot Count BNC being selected, then OK and Linear Region being clicked

5.12.  Then draw a region across bin 2 and name this region 2N [1].

5.12.1. SCREEN: To be provided by Author: Region being drawn, then region being named

6. Micronucleus (MN) Identification

6.1. To create a micronucleus mask, select a binucleated cell that contains a micronucleus from the image gallery [1] and open Masks in the Analysis tab [2].

6.1.1. WIDE: Talent selecting image, with monitor visible in frame
6.1.2. SCREEN: To be provided by Author: Masks being selected

6.2. To create a Spot Identification Mask 1, click New and Function and select Spot [1].

6.2.1. SCREEN: To be provided by Author: New and Function being clicked, then Spot being selected

6.3. Confirm that the Bright radio button is selected and select M07 under Mask [1].

6.3.1. SCREEN: To be provided by Author: Bright radio button being selected, then M07 being selected

6.4. Set the Spot to Cell Background Ratio and the Minimum Radius to 2 and set the Maximum Radius to 6 [1].

6.4.1. SCREEN: To be provided by Author: Spot to Cell Background Ratio and Minimum Radius being set to 2, then Maximum Radius being set to 6.

6.5.  Click OK and OK and New [1].

6.5.1. SCREEN: To be provided by Author: Ok, Ok, and New being clicked

6.6. [bookmark: _Ref524354204]Click the Spot M07, Channel 7, Bright, 2, 6, 2 mask and click the down arrow to add it to the mask definition and click the And and Not operators [1].

6.6.1. SCREEN: To be provided by Author: Mask being highlighted, down arrow being licked, then And and Not being clicked

6.7. Then click the Dilate Range LevelSet M07, Channel 07, Middle, 3, 80-5000, 0-1, 2 mask and click the down arrow to add it to the mask definition and click OK [1].

6.7.1. SCREEN: To be provided by Author: Mask being double-clicked, then Ok being clicked

7. Polynucleated Population Identification

7.1. To create a polynucleated population mask click Analysis, Masks, New, and Function [1].

7.1.1. SCREEN: Talent clicking Analysis, Masks, New, and Function, with monitor visible in frame

7.2. Under Function, select Range. Under Mask, elect Watershed Dilate LevelSet M07, Channel 07, Middle, 3, 2 and set the image to display to Channel 07 [1].

7.2.1. SCREEN: To be provided by Author: Range and Watershed Dilate LevelSet M07, Channel 07, Middle, 3, 2 being selected, then image to display being set to channel 7

7.3. Set the Minimum and Maximum Area values to 135 and 5000, respectively, and set the Minimum and Maximum Aspect Ratio values to 0.4 and 1, respectively [1].

7.3.1. SCREEN: To be provided by Author: Minimum and Maximum Area values being set, then Minimum and Maximum Aspect Ratio values being set

7.4. Click OK and in the Name field, change the text to read POLY (poly). Then click OK and Close [1]. 

7.4.1. SCREEN: To be provided by Author: Ok being clicked, then text being changed to POLY, then Ok and Close being clicked

8. BNC and MN Mask Examination

8.1. To create a custom view, click the Image Gallery Properties button and the View tab [1].

8.1.1. SCREEN: Talent clicking Image Gallery Properties and Composites tab, with monitor visible in frame

8.2. Open the Composites tab and click New. Under Name enter Channel 1-Channel 7 [1].

8.2.1. SCREEN: To be provided by Author: Composites tab being opened, then Ch01/Ch07 being entered

8.3. Click Add Image and, under Image, select Channel 1 and set the Percent to 100 [1].

8.3.1. SCREEN: To be provided by Author: Add being clicked, then Ch01 being selected and Percent being set

8.4. Click Add Image again, and under Image select Channel 7 and set the Percent to 100 [1].

8.4.1. SCREEN: To be provided by Author: Add being clicked, then Ch07 being selected and Percent being set

8.5. Click New and under Name enter BNC and MN masks [1].

8.5.1. SCREEN: To be provided by Author: New being clicked, and BNC and MN masks being entered

8.6. Then click Add Column and, under Image Type, select Channel 1 and under Mask select None [1].

8.6.1. SCREEN: To be provided by Author: Add Column being clicked, then Channel 1 and None being selected

(Author Comment: I’ve added some extra steps here. They do not add much extra time to the video, but they will make the footage of creating a custom view in the software more complete.)

8.7. Click Add Column and, under Image Type, select Channel 7 and under Mask select None [1].

8.7.1. SCREEN: To be provided by Authors: Add Column being clicked, then Channel 7 and None being selected

8.8. Add Column being clicked, then Composite radio button being clicked. Then OK being clicked. [TXT]

8.8.1. SCREEN: To be provided by Authors: Add column being clicked, composite radio button being clicked, then OK being clicked. Text: Continue with step 12 until all columns have been added.

8.9. Click the View pulldown menu and click the “BNC and MN masks” view. Click the “show /hide masks” button. 

8.9.1. SCREEN: To be provided by Authors: View pulldown menu being clicked, show/hide masks button being clicked.


9. Statistics Table Creation

9.1. To enumerate key events, open the Reports tab [1] and click Define Statistics Report [2].

9.1.1. SCREEN: Reports tab being opened
9.1.2. SCREEN: To be provided by Author: Define Statistics Report being clicked

9.2. Then in the new window, click Add Columns [1].

9.2.1. SCREEN: To be provided by Author: Add columns being clicked

9.3. [bookmark: _Ref526343681]To add the binucleated cell count statistic, under Statistics, select Count and under Selected Population, select the BNC population [1].

9.3.1. SCREEN: To be provided by Author: Count being selected, then BNC Population being selected

9.4. Then click Add Statistics to add the statistic to the list and save the template [1].

9.4.1. SCREEN: To be provided by Author: Add Statistics being clicked, then template being saved

9.5. Add statistics being clicked, close being clicked, OK being clicked, then template being saved [TXT]

9.5.1. Add statistics being clicked, close being clicked, OK being clicked, then template being saved. Text: continue adding statistics until table is complete. Continue adding statistics until table is complete (Author Comment: I also added some extra steps here to show the beginning and end of the creation of the statistics table…I think it will make more sense for viewers)

10. Experimental File Batch Processing

10.1. To batch process the experimental files, under the Tools menu, click Batch Data Files [1] and click Add Batch in the new window [2].

10.1.1. SCREEN: Talent clicking Batch Data Files, with monitor visible in frame
10.1.2. SCREEN: To be provided by Author: Add Batch being clicked

10.2. Click Add Files to select the experiment files to add to the batch and click the Select a template or data analysis file option [1]. 

10.2.1. SCREEN: To be provided by Author: Add Files being clicked, then Select a template or data analysis file option being clicked

10.3. Then click the Open folder icon to browse to and open the just-saved data analysis template [1].

10.3.1. SCREEN: To be provided by Author: Open folder icon being clicked, then template being located/opened

10.4. Click OK to close the current window. Then click Submit Batches to start the batch processing of all files.

10.4.1. SCREEN: To be provided by Author: OK being clicked and submit batches being clicked (Author Comment: Some extra steps here also to show viewers what the start of the batch mode looks like once files are added.)



Section – Results
11. Results: Representative Cell Scoring and Cytotoxicity Quantification 

11.1. Here four selected panels for identifying binucleated cells are shown [1].

11.1.1. LAB MEDIA: Figure 3ABCD

11.2. These bivariate plots enable the selection of binucleated cells [1] as well as the identification of those cells that have two nuclei with similar circularity [2], areas, and intensities [3], and that are well-separated from one another [4].

11.2.1. LAB MEDIA: Figure 3ABCD: JoVE Video Editor please emphasize arrow and image of binucleated cells in top left of Figure 3A
11.2.2. LAB MEDIA: Figure 3ABCD: JoVE Video Editor please emphasize plot in Figure 3B
11.2.3. LAB MEDIA: Figure 3ABCD JoVE Video Editor please emphasize plot in Figure 3C
11.2.4. LAB MEDIA: Figure 3ABCD JoVE Video Editor please emphasize plot in Figure 3D

11.3. These brightfield [1] and Hoechst images [2] as well as the binucleated cell [3] and micronucleus masks [4] facilitate the identification and enumeration of binucleated cells and micronuclei [5].

11.3.1. LAB MEDIA: Figure 3E: JoVE Video Editor please emphasizes BF column
11.3.2. LAB MEDIA: Figure 3E: JoVE Video Editor please emphasizes Hoechst column
11.3.3. LAB MEDIA: Figure 3E: JoVE Video Editor please emphasizes BNC mask column
11.3.4. LAB MEDIA: Figure 3E: JoVE Video Editor please emphasizes MN mask column
11.3.5. LAB MEDIA: Figure 3E: JoVE Video Editor please emphasize graph

11.4. Application of the Spot Count feature [1] uses the polynucleated mask [2] to identify mononuclear [3], trinuclear [4] and quad-nuclear cells [5].

11.4.1. LAB MEDIA: Figure 4 top of image only
11.4.2. LAB MEDIA: Figure 4 top of image only: JoVE Video Editor please emphasize POLY mask columns
11.4.3. LAB MEDIA: Figure 4 top of image only: JoVE Video Editor please add graph and/or arrows and emphasize 1N data line
11.4.4. LAB MEDIA: Figure 4: JoVE Video Editor please emphasize 3N data line
11.4.5. LAB MEDIA: Figure 4: JoVE Video Editor please emphasize 4N data line

11.5. The number of tri- and quad-nuclear cells can then be summed to obtain the final number of polynucleated cells [1] as well as to calculate the cytotoxicity [2].

11.5.1. LAB MEDIA: Table 1: JoVE Video Editor please emphasize Number of Polynucleated Cells column
11.5.2. LAB MEDIA: Table 1: JoVE Video Editor please emphasize % Cytotoxicity of column

11.6. Here representative genotoxicity and cytotoxicity values are for the aneugen colchicine [1], the clastogen mitomycin C [2], and a negative control demonstrate the validity of the protocol [3].

11.6.1. LAB MEDIA: Figure 5: JoVE Video Editor please emphasize Colchicine graph
11.6.2. LAB MEDIA: Figure 5: JoVE Video Editor please emphasize MMC graph
11.6.3. LAB MEDIA: Figure 5: JoVE Video Editor please emphasize Mannitol graph



Section - Conclusion
12. Conclusion Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.
12.1. Matthew Rodrigues: Labeling the cells with an appropriate concentration of DNA stain is critical to ensure high-quality image capture, permitting all key events to be easily identified and scored (Step: 3.7, 4, 5, 6) [1].
12.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera
12.2. Matthew Rodrigues: These techniques are also applicable to the micronucleus assay for radiation biodosimetry, which allows dose estimation in individuals who may have been exposed to radiation [1].
12.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera


 2018, Journal of Visualized Experiments	Page 1 of 16
image1.png




